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END USER LICENSE AGREEMENT

YOU SHOULD CAREFULLY READ THE FOLLOWING END USER LICENSE AGREEMENT BEFORE 
ACTIVATING OR USING THIS SOFTWARE PROGRAM.  By Activating, Copying, or otherwise Using this
software, you agree to be bound by the terms of this agreement.  If you do not agree to the terms of the 
agreement, please contact a WattPlot representative at http://www.WattPlot.com to arrange for a license fee 
refund.

This is a legally binding agreement between Andrew Welch, proprietor of Intallact, developer of the WattPlot 
software products (referred to herein as "Intallact" or “Developer”) and any person or company who purchases 
or activates a WattPlot license, or uses the software for any purpose (referred to herein as “End User”).

This software program, and any of the associated files installed with it or transferred from Intallact (via on-line 
transmission or otherwise) to update, supplement, or otherwise modify the software program, as well as any 
printed materials and any on-line or electronic documentation (the “User's Guide”), and any and all copies and 
derivative works of such software program and materials (collectively the “Software”) are the copyrighted 
work of Andrew Welch.  All use of the Software is governed by the terms of this End User License Agreement 
(“License Agreement” or “Agreement”).  The Software is distributed solely for use by authorized end users 
according to the terms of the License Agreement.  Any use, reproduction or redistribution of the Software not 
expressly authorized by the terms of the License Agreement is expressly prohibited.

1. OWNERSHIP.  All title, ownership rights, and intellectual property rights in and to the Software and all 
copies thereof (including, but not limited to, any titles, computer code, artwork, unique interface designs, 
trademarks, proprietary file formats, any related documentation (embedded or separate), and “applets” 
incorporated into the Software) are owned or expressly licensed by Licensor.  The Software is protected by the 
copyright laws of Canada, international copyright treaties and conventions, and other laws.  All rights are 
reserved.  The Software may contain certain licensed materials, and the licensors of those materials may 
enforce their rights in the event of any violation of this License Agreement.

2. LICENSE.  Any data-sharing connection between this copy of the Software and one or more electrical power
monitoring devices (such as a MATE device from OutBack Power Systems), through direct cabling, network 
connection, file-sharing, modem, software interaction, or any other means that does not include a separate 
expressly licensed copy of the Software as a critical link in that communication, is considered an “Active Use” 
of the license.  Each license purchased for this Software allows the Software to be deployed for “Active Use” 
on one computer only.  You may transfer a license to another computer if it is first removed from the original 
computer.  Licenses lost through hardware failure, user error, or otherwise made inaccessible MAY be replaced
by Intallact at the discretion of the Licensor.

3. END USER RESPONSIBILITY.  Subject to the Grant of License hereinabove, you may not, in whole or in 
part, copy, photocopy, reproduce, translate, reverse engineer, derive source code, modify, disassemble, 
decompile, or create derivative works based on the Software, or reproduce the unique interface aspects or Look 
and Feel of the Software, or create software that generates output using the specific proprietary file formats of 
this Software, or remove any copyright or proprietary notices or labels on the Software.  You may not circulate 
or cause to be circulated or make public any aspect of the license activation process, including, but not limited 
to, activation codes (whether delivered from Licensor or generated by Software), software serial numbers, 
unique “PC ID” as generated by Software, or any other information which could knowingly compromise the 
security and integrity of the licensing process, except where such information transfers are between you and the
Licensor or their authorized agent.  Failure to comply with the restrictions and limitations contained in this 
Section 3 shall result in immediate, automatic termination of the license granted hereunder and may subject you
to civil and/or criminal liability.

4. TERMINATION.  This License Agreement is effective until terminated.  You may terminate the License 
Agreement at any time by (i) running the License removal function included with this Software; and (ii) 
permanently removing the Software from your hard drive; and (iii) notifying Licensor of your intention to 
terminate this License Agreement and supplying evidence that the License removal function was run.  Licensor 
may, at its discretion, terminate this License agreement in the event that you fail to comply with the terms and 
conditions contained herein.  In such event, you must immediately and permanently remove the Software from 
your hard drive.  Upon termination of this Agreement for any reason, all licenses granted herein shall 
immediately terminate.
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5. LIMITATION OF LIABILITY.  Neither Licensor nor its subsidiaries or affiliates shall be liable in any way 
for loss or damage of any kind resulting from the use of the Software, including, but not limited to, loss of data,
power equipment damage, electrical power loss, loss of goodwill, work stoppage, computer failure or 
malfunction, or any and all other damages or losses.  Licensor shall not be responsible for any interruptions of 
service, including, but not limited to, software or hardware failures or any other event which may result in loss 
of data, power failure, or disruption of service.  In NO event will Licensor be liable to you for any indirect, 
incidental, special, exemplary, or consequential damages, including, but not limited to events arising from 
normal Software use or errors in Software.  Some countries and regions do not allow the exclusion or limitation
of incidental or consequential damages, so the above limitations may not apply to you.

6. EQUITABLE REMEDIES.  You hereby agree that Licensor would be irreparably damaged if the terms of 
this License Agreement were not specifically enforced, and therefore you agree that Licensor shall be entitled, 
without bond, other security, or proof of damages, to appropriate equitable remedies with respect to breaches of
this License Agreement, in addition to such other remedies as Licensor may otherwise have available to it 
under applicable laws.  In the event any litigation is brought by either party in connection with this License 
Agreement, the prevailing party in such litigation shall be entitled to recover from the other party all the costs, 
attorneys' fees and other expenses incurred by such prevailing party in the litigation.

7. CHANGES TO THE AGREEMENT.  Intallact reserves the right, at its sole discretion, to change, modify, 
add to, supplement or delete any of the terms and conditions of this License Agreement, effective upon prior 
notice as follows: Intallact will post notification of any such changes to this License on the WattPlot web site 
and will post the revised version of this License Agreement in this location, and may provide such other notice 
as Intallact may elect in its sole discretion, which may include by email or pop-up screen.  If any future changes
to this License Agreement are unacceptable to you or cause you to no longer be in compliance with this License
Agreement, you may terminate this License Agreement in accordance with Section 4 herein.  Your installation 
and use of any updated or modifications to the Software or your continued use of the Software following notice
of changes to this Agreement as described above will mean you accept any and all such changes.  The 
Developer may change, modify, suspend, or discontinue any aspect of the Software at any time.  The Developer
may also impose limits on certain features or restrict your access to parts or all of the Software without notice 
or liability.  You have no interest, monetary or otherwise, in any feature or content contained in the Software.

8. MISCELLANEOUS.  This License Agreement shall be deemed to have been made and executed in Canada 
without regard to conflicts of law provisions, and any dispute arising hereunder shall be resolved in accordance 
with the law of Canada.  You agree that any claim asserted in any legal proceeding by one of the parties against
the other shall be commenced and maintained in Canada, having subject matter jurisdiction with respect to the 
dispute between the parties.  In the event that any provision of this License Agreement shall be held by a court 
or other tribunal of competent jurisdiction to be unenforceable, such provision will be enforced to the 
maximum extent permissible, and the remaining portions of this License Agreement shall remain in full force 
and effect.  This License Agreement constitutes and contains the entire agreement between the parties with 
respect to the subject matter hereof  and supersedes any prior oral or written agreements.
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Overview

The options for monitoring your OutBack renewable energy system can be restrictive:  An OutBack 
MATE cannot log your system data.  A MATE or AXS Port cannot proactively contact you to let you 
know of critical system incidents.  Only one computer can connect to any OutBack monitoring device.

WattPlot™ NetMATE provides a simple, sophisticated, and inexpensive solution to these shortcomings.

Main Features

 Can connect  to your Outback MATE, MATE3, or AXS Port directly, by network, or over the 
internet.

 Provides email or text message notifications of a variety of system events, including warnings 
and errors, configurable by the user.

 Makes any OutBack monitoring device data accessible via the WattPlot TCP Server, allowing 
any other computers running WattPlot software to piggy-back onto the data stream.

 Logs incoming system data, either as raw text (.OBM extension) or as MATE3 SD Card format 
files (.CSV extension).

The Getting Started section that follows provides a step-by-step guide to getting your software installed 
and configured right away.

The Using the WattPlot NetMATE Program section provides more detailed information on each 
feature.
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What’s New in Version 5.1?

WattPlot NetMATE 5.1 catches the application up with capabilities that have been 
added to the other WattPlot tools.  The major improvements over NetMATE 5.0 
are listed below:

 WattPlot NetMATE can now monitor and pass on a data stream from an 
OutBack AXS Port device, using its serial Modbus connectivity.  (see page 
11)

 The MATE Data Source dialog box has been redesigned to offer simpler 
connection options and a more informative traffic screen.  (see page 17)

 Raw MATE data capture can now be stored in compressed MATE3 SD card 
CSV format.  (see page 24)

 You can now change the folder where NetMATE logs all of its data.  (see 
page 30)

 The Auto-start option will now create an entry in your Windows Startup 
program list.  (see page 31)
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Getting Started

WattPlot™ NetMATE is part of the WattPlot™ 5 suite of software tools for monitoring and controlling 
renewable energy devices such as inverters and charge controllers from OutBack Power Systems.

The WattPlot™ NetMATE application can…

 Connect to an OutBack MATE, MATE3, or AXS Port monitoring device, accept the renewable 
energy performance data, and make it available to compatible TCP clients via a built-in TCP/IP 
Server.

 Analyse incoming data and send email notifications of critical system events.

 Convert a MATE3 data stream to the original MATE format, allowing WattPlot Monitor versions
4.7.1 and higher to monitor MATE3 data.

MATE, MATE3
  or AXS Port WattPlot NetMATE

     TCP/IP Server    Clients monitoring
         using other
WattPlot applications

This Getting Started section will guide you through the installation and configuration of the software.  
The Using the WattPlot NetMATE Program section that follows provides more detailed information on
each feature.

If you have any questions not answered in this document, or would like to send us feedback or 
suggestions, you can contact us at:

techsupport @ WattPlot .com
http://WattPlot.com
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System Requirements

In order to monitor an OutBack system using any WattPlot™ software, you will need at least four things:

 An OutBack MATE, MATE2, MATE3, or AXS Port monitoring device

 A cable for getting data OUT of the MATE.  For a MATE or MATE2 this must be an appropriate
serial cable (see Appendix A – Serial Cable Specifications).  For a MATE3, you will need a 
standard CAT5 network cable (unless you have the optional USB card installed).  AXS Ports 
connect via a network cable (serial modbus protocol).

 A computer running Microsoft Windows (XP or later), or equivalent emulation

 A way of getting data IN to the computer.  This might be no more than the cable referred to 
above, or it might include some combination of the following:

 Serial/USB conversion cable and software

 Serial modem(s) and phone/cellular connection

 Serial-to-IP converter (and router?)

 Internet access

The MATE and MATE2 monitoring devices are technologically equivalent.  This User’s Guide will 
usually just refer to these device types as a MATE.  The MATE3 device, on the other hand, is very 
different, as is the AXS Port device:

MATE MATE2 MATE3 AXS Port

Software Download

All of our software may be downloaded from:  http://WattPlot.com/download.htm

For WattPlot NetMATE, download and save  NetMATESetup.msi – a Windows Installer Package 
which will guide you through the installation process when you get to that step in the setup process.

If you are connecting WattPlot Monitor to a MATE/MATE2 device, proceed to the next section.

If you’re connecting to a MATE3 device, skip down to the MATE3 Connection Options section.

If you’re connecting to an AXS Port device, skip down to the AXS Port Connection section.
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MATE/MATE2 Connection Options

There are different ways to connect your MATE to a computer.  The best option for your installation 
depends on individual circumstances, and may require assistance from your local network professional.

Option 1 – Local Serial Connection:

The most common scenario has the WattPlot
NetMATE program running on a computer at
the same location as the MATE and connected
directly to it by a single serial or serial/USB cable.

CABLE NOTE:  A serial cable (with pins 2, 3, 4, 5, and 7 straight through) must be connected between a serial 
port on the back of your computer (or modem) and the DB09 serial connector on the bottom of your OutBack 
MATE (next to where the network cable runs from your MATE to your OutBack system).  If you have a MATE2 
unit, you may have to open the case to break-out the serial port access opening.

If your computer doesn’t have a 9-pin serial port, there are some third-party products that convert a serial connection
to a USB connection.  Not all serial-to-USB conversion products work with the OutBack MATE.  We post the 
products we know about (either that work or that don’t) at  http://WattPlot.com/faq.htm#USB.

Option 2 – Remote Serial Connection:

A similar connection might also be accomplished for a MATE at a remote location, using a pair of serial 
modems to connect the two devices through a telephone connection:

Option 3 – TCP/IP Connection:

Another option is to use a Serial-IP conversion device to convert the MATE’s serial signal to TCP/IP, 
which can communicate with the WattPlot NetMATE program running on a computer locally (over a 
Local Area Network (LAN) or remotely (over the internet):

You can read about one such device in a PDF document at  http://WattPlot.com/WattPlot_IP.pdf.  
Some Serial-to-IP converters come with bundled software that allows you to convert the TCP/IP data back to a 
virtual serial COM port on the monitoring computer.  If this is between COM1 and COM16, then WattPlot can 
access this data just as if it were connected directly by a serial cable.  The virtual COM port is not required however 
– WattPlot can get data directly from a specified IP Address and port.
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MATE/MATE2 Setup

STEP 1. Take note of your MATE serial number.  You will need this for the Activation process.  You 
can get the unit to display the serial number by unplugging the network cable (leading to 
your Outback system) from your MATE and then plugging it back in.  It is also printed on a 
sticker found on the back of most MATE units.  (The sticker is internal for MATE2 units.)  It 
is also generally written on the box or in the documentation that you received with your 
Outback components.

STEP 2. Ensure that your MATE device is properly connected to your OutBack inverter, charge 
controller, or HUB, depending on your specific system configuration.  (Refer to your MATE 
manual for details.)

STEP 3. The default setup of the OutBack MATE is not configured to transmit performance data.  
You must turn on this feature.  From the main menu on the MATE select SETUP, then 
MATE, then PG2, then COMM, then PC, and then ON, to activate the serial 
communications port on the MATE.

STEP 4. If your system includes a FLEXnet DC monitor, only Shunt 1 (A) is enabled by default.  If 
you are using Shunt 2 (B) and/or Shunt 3 (C), then they must be enabled on the MATE in 
order to receive data for them.  This is done from the MATE’s ADV/DC/SHUNT menu entry.

STEP 5. Connect your MATE to the monitoring computer (or modem or serial-IP conversion device) 
using a serial cable.  (See MATE/MATE2 Connection Options above.)

NOTE:  For MX-60 charge controller data reception, the MX itself must be displaying the 
Status screen.  Going to another screen on the MX (e.g. the MISC screen) can lock data 
values, resulting in invalid PV Amps being reported.  This is a known OutBack bug which 
does not apply to FLEXmax charge controllers.  (The WattPlot Monitor program can 
sometimes detect this condition and display a warning message, but it is not detectable by 
WattPlot NetMATE.)

Your MATE is now ready.  Proceed to STEP 6 under NetMATE Program Installation.

_____________________________________________________
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MATE3 Connection Options

There are two different ways to connect your MATE3 to a computer.  The best option for your installation
depends on individual circumstances, with some key functionality differences, as noted below.

Option 1 – UDP/IP Connection:

The MATE3 offers a UDP/IP data stream via a CAT5 network cable.  Please refer to your MATE3 
Owner’s Manual for detailed instructions on completing this connection.  Note that the MATE3 ‘pushes’ 
data out to a single IP Address.  When you are setting up the UDP Network Data Stream on the MATE3, 
you will be supplying the IP Address and Listening IP Port of the monitoring computer, not the 
address of the MATE3.

This connection option comes standard with the MATE3.  It has one significant limitation:  You cannot 
send MATE3 commands or program MATE3 settings using the connection method.

Option 2 – USB Connection:

An optional USB Card may be purchased and
installed into the MATE3, allowing you to
connect to it using a standard USB cable.  Please
refer to the MATE3 USB Card Manual for
detailed instructions on completing this
connection.

Note that a USB connection does support MATE3 commands, including the programming of some 
MATE3 settings.  The WattPlot tools take full advantage of these capabilities.  NetMATE can receive 
MATE3 Commands from other WattPlot programs and pass them on to the MATE3.

MATE3 Setup

STEP 1. Take note of your MATE3 serial number.  You will need this for the Activation process.  It 
is printed on a sticker on the back of the MATE3.  It is also generally written on the box or in
the documentation that you received with your Outback components.

STEP 2. Ensure that your MATE3 device is properly connected to your OutBack inverter, charge 
controller, or HUB, depending on your specific system configuration.  (Refer to your MATE3
manual for details.)

STEP 3. The default setup of the OutBack MATE3 is not configured to transmit performance data.  
You must turn on this feature.  From the MATE3’s Main Menu, go to Settings, System, 
then Data Stream to setup the Network Data Stream.  The setup will depend on whether you
are using the UDP/IP (Network) connection or the USB (Serial) connection, as shown below.
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Settings for UDP/IP (Network)

This primarily involves enabling the 
Network Data Stream and putting in the 
Destination IP – that being the IP address of
the computer running WattPlot NetMATE.

NOTE that the MATE Data Source dialog
box of the WattPlot NetMATE program 
supplies information like the computer’s 
IP Address and recommended IP Port 
number, which you will need to supply in 
the MATE3 Network Data Stream setup.

Settings for USB (Serial)

All you have to do is enable the Serial Data 
Stream and ensure the USB driver that cam 
with the card is installed and set to the 
correct baud rate.

Note that it is acceptable to enable both 
Network and Serial Data Streams.

You should completely ignore the Ethernet Addresses screen on the MATE3.  That 
information has no impact on NetMATE communications.  Remember, NetMATE does not 
actively connect to the MATE3 – the MATE3 actively sends to the listening NetMATE PC.

Please refer to your MATE3 Owner’s Manual for more detailed instructions on configuring 
and enabling the Network or Serial Data Stream.

STEP 4. If your system includes a FLEXnet DC monitor, only Shunt 1 (A) is enabled by default.  If 
you are using Shunt 2 (B) and/or Shunt 3 (C), then they must be enabled on the MATE3 in 
order to receive data for them.  This is done from the Main Menu/Settings Menu/Battery 
Monitor/Shunt Enable screen on the MATE3.

STEP 5. Connect your MATE to the monitoring computer (or router) using a CAT5 network cable.  
(See MATE3 Connection Options above.)

NOTE:  For MX-60 charge controller data reception, the MX itself must be displaying the 
Status screen.  Going to another screen on the MX (e.g. the MISC screen) can lock data 
values, resulting in invalid PV Amps being reported.  This is a known OutBack bug which 
does not apply to FLEXmax charge controllers.  (The WattPlot Monitor program can 
sometimes detect this condition and display a warning message, but it is not detectable by 
WattPlot NetMATE.)

Your MATE3 is now ready.  Proceed to STEP 6 under NetMATE Program Installation.

_____________________________________________________
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AXS Port Connection

The AXS Port device uses the Modbus protocol to create a link between your system and your computer. 
By adding it to your local network, WattPlot can query the device for system data on a regular basis.

TCP/IP Connection:

The AXS Port communicates via a CAT5 network cable.  Please refer to your AXS Port Owner’s Manual 
for detailed instructions on completing this connection.  Note that unlike the MATE and MATE3 devices,
the AXS Port does not specifically supply a data stream.  Instead, WattPlot polls it for data every second.  
(The polling frequency may be user-adjustable in future releases.)

The AXS Port does support remote commands and system setting programmability, however that 
functionality is not implemented in WattPlot at this time.

AXS Port Setup

STEP 1. Ensure that your AXS Port device is properly connected to your OutBack inverter, charge 
controller, or HUB, depending on your specific system configuration.  (Refer to your AXS 
Port manual for details.)

STEP 2. Connect your AXS Port to the network (or computer) using a CAT5 network cable.

STEP 3. The AXS Port is accessed by an IP Address.  This can be dynamically set automatically by 
the local network (DHCP), or you can program a static IP address into the device.  The 
DHCP setting is the default for the AXS Port device.  While WattPlot supports both options, 
the static IP address option assumes that other software was used to program it into the AXS 
Port.  WattPlot does not currently support this capability.

Proceed to STEP 6 under NetMATE Program Installation on the next page.
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NetMATE Program Installation

If you’ve completed the steps for MATE Setup, MATE3 Setup, or AXS Port Setup, you can continue 
with program installation:

STEP 6. From  http://WattPlot.com/download.htm , download the NetMATE setup 
application, called NetMATESetup.msi.

STEP 7. Save the downloaded file on your computer and run  NetMATESetup.msi  (a Windows 
Installer Package).  The setup program will guide you through the installation process.  We 
recommend installing the program (NetMATE.exe) in the default folder specified, which is 
Program Files\WattPlot.  The installation process will also add a shortcut and other 
Resources to your Windows Start menu.

STEP 8. To run the program, click on the WattPlot NetMATE entry of the Windows Start menu 
(under All Programs…WattPlot).  When WattPlot NetMATE is first run, you may be asked 
to Accept the End User License Agreement, a copy of which is included in this manual.

The remaining steps may or may not be prompted for, depending on whether this is your first 
WattPlot software installation, or if NetMATE can use settings that you already have on file.

STEP 9. If your computer is connected to the internet, then you will be prompted to enter your email 
settings.  (See the Email Settings section.)

STEP 10. You will then be prompted to enter a brief descriptive System Name for this installation:

The System Name identifies this particular MATE connection and the OutBack system that it
monitors.  It will be included in any emails that WattPlot NetMATE sends out.
NOTE:  System Names cannot be easily changed after they have been defined.  Please 
contact WattPlot Support if a change is required.

The Data Folder specifies where WattPlot will store configuration and performance data.  It is
recommended that you accept the default.  You can always change this location later.

If you are defining multiple systems or connection methods, use the Description field to 
provide more details.

STEP 11. After the MATE serial number has been verified, you must activate the WattPlot NetMATE 
program with a license code from intallact.  (See Activation below.)

STEP 12. Configure the MATE Data Source for WattPlot NetMATE.  (See MATE Data Source 
Definition below.)
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STEP 13. If you are using the built-in WattPlot NetMATE TCP Server  to supply the data stream to 
other monitoring computers or programs, you will need to configure that.  (See the WattPlot 
TCP/IP Server section.)

STEP 14. Finally, you should review the program AutoStart and Notification options.

That’s it!  WattPlot NetMATE is now ready to monitor your OutBack system data stream, make it 
available to other programs or computers, and notify you of any critical system events.

More information is available in the Using the WattPlot NetMATE Program section.

_____________________________________________________

Release Announcements and other Special Notifications

Installations of WattPlot NetMATE that are connected to the internet will check for new releases of the 
software and other special notifications from WattPlot.  You will be advised if a new version of 
NetMATE has been released into production when you first run the program.

You can adjust how often NetMATE checks for such notifications, using the dropdown menu at the 
bottom of the notification screen, or even turn them off all together.  (See Check for New Release.)  Note
that installations with AutoStart turned on will not receive these notifications, allowing the program to go
directly to work when Windows starts.

You can also request a manual check for a new release and other special notifications, using the Check 
for New Release entry of the File menu.

To check for a new release yourself, go to:  http://WattPlot.com/update_nm.htm
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Email Settings

WattPlot NetMATE has a powerful built-in email capability.  Email can be used to:

 Activate your software automatically.
 Notify you of critical OutBack system events.
 Send error messages to WattPlot’s technical support for fast resolution.

The Email Settings dialog box will be presented early in the installation process.  You can also access it 
later from the Email Settings entry of the Options menu.

Local (From) Address This is the email address that you normally send from.  Emails sent by 
NetMATE will have this address as the ‘reply-to’.  It will also be the 
address system event notifications will be sent to if no Default 'TO' 
Addresses are specified.

Default 'TO' Address(es) You can specify one or more email addresses which will receive 
NetMATE’s system event notifications.  If none are specified, the Local 
(From) Address will be used.  All email addresses must be of the 
“account@domain.ext” format.

SMTP Login

The second section is where you specify your SMTP Server, Port number (if required), SSL Option, User 
Account, and Password.  (The Common Providers menu has the settings for AOL, AT&T, Comcast, 
Gmail, Hotmail, Lycos, Outlook.com, Verizon, and Yahoo.)  The server, user account, and password 
must be present in order to save the data on this screen.  If you are not sure what these settings should be, 
you can often get them by looking at the settings in your regular e-mail program.  If you read your mail 
on-line through a browser, those sites will often have instructions on how to send via SMTP as well.
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Some common SMTP Host servers (such as “smtp.gmail.com”) are recognized by WattPlot and will 
have various other settings defaulted in for you.

Your SMTP Login password and other settings are stored securely in WattPlot’s local data folder in a file 
called vbmail.dat.  WattPlot will only ever transmit data or settings specific to the WattPlot software. 
Login settings will never be transmitted.

Test

It is strongly recommended that you test your SMTP settings.  You can test them by clicking the Test 
button.  A test email message will be sent using the specified Local (From) Address as both the sender 
and recipient.  If all of the settings are correct, you should see the test email message when you check 
your email at that address.  Note that there may be a slight delay while the SMTP server processes the 
email.

Text Messages Instead of Email

Most mobile phone providers offer an email address specific to your phone, such that an email sent to that
address will be converted to a text message and passed on to your phone.  By providing that email address
as a Default 'TO' Address, you can have WattPlot NetMATE send critical system notifications to your 
phone as SMS text messages!

Even if your phone already receives email, there is often a significant time lag for notification of a new 
message, whereas SMS text messages are immediate.

Contact your mobile phone provider for more information.
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Activation

WattPlot NetMATE will ask if you want to 
initiate the Activation procedure, starting 
with a prompt to enter your MATE serial 
number.  (See STEP 1 of the MATE or 
MATE3 Setup sections.)  The full serial 
number is required, including any leading 
letters.  (This prompt may not apply for AXS 
Port devices.)

After the device serial number has been 
verified, the program will display a Unique 
PC ID for your computer and prompt for an 
Activation Code, as shown at right.

If you have entered Email Settings, and your
computer can access the internet, WattPlot
NetMATE can automatically register your
system and issue you with a trial Activation
Code, as indicated by the large button labeled 
Request Immediate Trial Activation by Email.  If NetMATE can request an activation but cannot issue
an automatic one for any reason, then this button may be labeled Request Activation Code by Email, 
which means that we will have to issue an Activation Code manually (usually within 24-48 hours).  If 
email is not possible for some reason, then no such button will be visible.

If WattPlot cannot automatically email your activation request, please take note of the unique PC ID that 
is displayed (which will be different from the one shown above) and then click Cancel.  You will have to
email that PC ID to us at  activation @ WattPlot .com  so that we can get a valid Activation Code 
to you.  You can typically expect a response with your Activation Code in 24 to 48 hours.

When you receive your Activation Code, run the program again and enter the code at this prompt 
EXACTLY as you received it.  (We suggest a copy-and-paste from our email directly into the activation 
screen input field.)  Click Activate.

Note:  If you are currently working with an evaluation copy of WattPlot, and have purchased a permanent
license, you can recall this window to enter your new permanent Activation Code by selecting License 
Activation from the File menu.

IMPORTANT NOTICE

WattPlot Activation Codes are issued ONCE.  If you later want to move this license to a different PC, you
can do that yourself.  (See Moving your WattPlot™ License section.)
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MATE Data Source Dialog Box

The MATE Data Source dialog box is accessed from the MATE menu.  It defines where WattPlot will be 
getting its data from, and the communication protocol to be used.  The following table gives a summary 
of the possible Data Sources and the corresponding Communication protocols:

Data
Source

Communication Protocol Notes

MATE /
MATE2

Serial cable to COM port
Simple serial cable connection from 9-pin 
MATE connector to PC COM port.

Serial/USB converter
Conversion cable connection from 9-pin MATE
serial connector to PC USB port (with driver to 
create a virtual COM port).

TCP/IP using Serial-to-IP converter

Serial cable connection from 9-pin MATE 
connector to Serial-to-IP converter.  Resulting 
TCP/IP data stream is accessible by a specific 
IP address and port.

Virtual COM port using Serial-to-IP 
converter

Serial cable connection from 9-pin MATE 
connector to Serial-to-IP converter.  Resulting 
TCP/IP connection is converted to a virtual 
COM port on receiving computer.

MATE3

Network cable(UDP/IP)
This is the standard protocol for the MATE3.  
Data is sent through a CAT5 network cable to 
the specified IP Address and IP port.

USB (optional MATE3 USB card 
installed)

Optional connection method for the MATE3.  
(Requires a USB card to be installed in the 
MATE3.)  Data is sent directly from the 
MATE3 to a USB port.

AXS Port

DHCP (AXS IP address assigned by 
network)

WattPlot will access the AXS Port via an IP 
address assigned by the local network.  (This is 
the default setting on the AXS Port.)

Static (AXS IP address set by you)

WattPlot will access the AXS Port via an IP 
address specifically programmed into the 
device.  (This assumes other software was used 
to program the AXS Port.  WattPlot does not 
currently support this capability.)

TCP
Server

TCP/IP to a remote WattPlot program
This application will run as a TCP Client to a 
WattPlot TCP Server running on another 
computer.

TCP/IP to another WattPlot app. on 
this PC

This application will run as a TCP Client to a 
WattPlot TCP Server running on this computer.

Data File Packets read from file (simulation)

Instead of getting live data from a MATE, 
WattPlot can work from data previously 
captured and stored in a text file.  (See 
Advanced Settings for how to use WattPlot to 
create these files.)

To define a new connection, begin by selecting the Data Source from the dropdown menu at top left of 
the MATE Data Source dialog box.  The Communication menu next to it will then contain the possible 
protocols for the selected data source.
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The next section of the screen will change to accept the additional settings required for the selected 
communication protocol, as described separately below.

(Note that the WattPlot Connection Wizard, available in past versions of WattPlot, has now been replaced
by this simplified and more sophisticated MATE Data Source dialog box.)

Serial Connection (MATE/MATE2)

     Serial cable to COM port
 or Serial/USB converter
 or Virtual COM port using Serial-to-IP converter

The default setup of the original OutBack MATE is not configured to transmit performance data.  You 
must turn on this feature.  From the main menu on the MATE select SETUP, then MATE, then PG2, 
then COMM, then PC, and then ON, to activate the serial communications port on the MATE.

WattPlot will ask you to specify the serial COM port that applies to the MATE connection.  It could be a 
physical COM port, or it might be a virtual COM port created by the specific communications software 
that you are using.  Only COM ports found by WattPlot on your computer (from COM1 to COM16) will 
be presented as options.  See the Data Source Dialog Box Remainder for more information (including 
what to do if you are not sure of the COM Port).

TCP/IP Connection

    TCP/IP using Serial-to-IP converter
or TCP/IP to a remote WattPlot program
or TCP/IP to another WattPlot app. on this PC
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WattPlot will ask you to specify the IP Name/Address and IP Port, corresponding to your Serial-
TCP/IP conversion device or WattPlot TCP/IP Server.  If this is a TCP client/server connection, it will 
also prompt for the optional Password.  See the Data Source Dialog Box Remainder for more 
information.

IP Name/Address Enter the IP name or address of your Serial-TCP/IP conversion device 
(or separate WattPlot TCP/IP Server).  Note that you cannot use TCP/IP 
to connect directly into your MATE3.  The MATE3’s TCP/IP address is 
for web browsers only.  See the UPD/IP Connection instead.

IP Port This is the IP port corresponding to your Serial-TCP/IP conversion 
device (or separate WattPlot TCP/IP Server – default is 9091).

Password If you are connecting into a separate WattPlot TCP/IP Server with 
restricted access, you will need to enter the corresponding password here.

UDP/IP Connection (MATE3)

Network cable(UDP/IP)

The typical connection method for MATE3 devices is UDP/IP.  This protocol involves the MATE3 
‘pushing’ data out to an IP Address and port that you specify in the MATE3 settings.  This is described in
Step 3 of the MATE3 Setup.  From the MATE3’s Main Menu, go to Settings, System, then Data 
Stream to setup the Network Data Stream:

The IP Address of the PC in this example is 192.168.1.4.  The only setting that WattPlot needs to know is 
the IP port that the MATE3 will be pushing data out to.  See the Data Source Dialog Box Remainder 
for more information.

IP Port This port should be the same port that you specified on the MATE3 as 
the Destination Port.  (Default is 57027.)
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Edit IP The MATE3 needs a Destination IP – that being the local IP address of 
this computer – in this format: ###.###.###.###.  Normally WattPlot 
can easily determine the IP address of the computer that it’s running on, 
and it will display it in the instructions, as shown above.  However, in 
rare circumstances (such as when WattPlot is being run under Windows 
emulation software), you will have to determine the IP address yourself.  
(The IP address can usually be determined by going to the Windows 
Command Prompt and running “ipconfig”.)  You can then supply it 
here by clicking the Edit IP button so WattPlot has a record of it, but 
remember – it is the MATE3 that needs this setting, not WattPlot!

USB Connection (MATE3)

USB (optional MATE3 USB card installed)

By installing the optional MATE3 USB Card from OutBack, you can add a new level of powerful 
connectivity to your MATE3, including support for sending commands to control your MATE3 remotely.
The MATE3 setup for USB is described in Step 3 of the MATE3 Setup.  From the MATE3’s Main 
Menu, go to Settings, System, then Data Stream to enable the Serial Data Stream:

You will also need to install the USB driver that came the USB card on to your computer.  This driver 
will make the MATE3 USB connection available as a regular serial COM port.  See your MATE3 
Owner’s Guide for details.

WattPlot will ask you to specify the serial COM port that was created by the USB driver.  Only COM 
ports found by WattPlot on your computer will be presented as options.  See the Data Source Dialog Box
Remainder for more information (including what to do if you are not sure of the COM Port).
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AXS Port Connection

DHCP (AXS IP address assigned by network)
Static (AXS IP address set by you)

The OutBack AXS Port device is accessed by TCP/IP, either at an IP address assigned by the network 
(with DHCP enabled) or at a user-specified IP address (with DHCP disabled).

WattPlot will ask you to specify the AXS Port IP Name/Address and IP Port.  See the Data Source 
Dialog Box Remainder for more information (including what to do if you are not sure of the IP address).

IP Name/Address Enter the IP name or address of your AXS Port device.

IP Port This is the IP port that your AXS Port is using for Modbus 
communication.  (The default is 502.)

Password If you have programmed your AXS Port with a password, you will also 
need to supply it here.

Note that AXS Port data is polled by WattPlot.  The default frequency for monitoring system data is once 
per second.  This can be modified in Advanced Settings (see Advanced Settings).

Data File Connection

Packets read from file (simulation)

It is sometimes useful to be able to demonstrate the operation of WattPlot when there is no live MATE 
currently connected to the system, especially when trying to explain the operation of the program or of 
the OutBack system.  This simulation functionality is built into WattPlot.

To use existing data instead of a live system connection, select Data File as the Data Source.  WattPlot 
will prompt you for a Data Source file (with an .OBM extension – see Advanced Settings for how to 
create these).  The Advanced Settings will also let you select a data stream running at twice the normal 
speed for faster simulations.

Note that any changes made to the various WattPlot settings (such as display options, window placement, 
etc.) will be saved to the configuration file, just as if WattPlot was running live.
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See the Data Source Dialog Box Remainder for more information.

Data source file The file containing the raw MATE data strings, created by an earlier run 
of the Monitor program or other WattPlot tool.  These files typically 
have an .OBM extension (for OutBack MATE data).  If the file exists, 
then the first few lines of data will be shown in the display window.

NOTE:  If the devices in the data file don’t match the devices in your 
system, it is recommended that you create a new System Definition so 
that you can keep the configurations separate.

Browse Allows you to find the Data source file you want to use.

Repeat data at end-of-file If this option is checked, then when WattPlot reaches the end of the 
captured data, it will return to the beginning.  If the option is not 
checked, then WattPlot will stop when it gets to the end of the data.

________________________

When the status is “Active” and you see MATE data scrolling through the display area, you have 
completed the definition of your connection and it is ready for WattPlot NetMATE.  You will likely next 
want to set up the WattPlot TCP/IP Server.

Once all is ready, click OK to save your setup.  (This dialog box can be recalled by selecting MATE Data 
Source from the Options menu.)

built by intal act version 5.1.0 © Copyright 2016, Andrew Welch.  All rights reserved.



WattPlot™ NetMATE – User’s Guide 23

Data Source Dialog Box Remainder

WattPlot only allows you to click the OK button when the communication settings have been confirmed.  
In this case, you will typically see OutBack system data in the large results window, and the status in the 
lower left will be Active, as shown:

There are also a few other features worth noting:

HELP Some communication protocols require special set ups on the connection 
device itself.  Clicking the HELP button will display any special set up 
instructions.

SCAN for Data If you are not certain of the connection parameters, but all hardware 
connections have been made, WattPlot can do some sophisticated scanning 
of your PC communication ports in an attempt to find the correct settings.  
For example, if the selected protocol uses a COM port, WattPlot can scan 
COM ports 1 through 16, looking for OutBack system data.

Better yet, if you are unsure of an IP address on a local network, WattPlot 
can scan a range of addresses, based on the PC’s own IP address, and 
assuming that the default IP port applies.  Scans for data always display the 
results for each attempt.
NOTE:  Allowing for time-outs etc., this process can take a while.
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TEST Communication After you have changed some communication parameters, you can test the 
new settings by clicking this button.  You may have to click this button in 
order to enable the OK button so that you can save your settings.

Advanced Takes you to advanced settings, described in the Advanced Settings section.

Cancel Test/Port Scan Click this button to cancel a communication test or port scan, and suspend 
any data stream.

Setup TCP Server Click this button to configure the WattPlot TCP/IP Server.

The large Results Window in the center of the MATE Data Source dialog box will show the progress of 
your setup activities.  The contents are color-coded:

Black Actual system data coming over the link

Green Requests or actions being undertaken by WattPlot

Blue Information derived by WattPlot

Red Error messages

Advanced Settings

Clicking the Advanced button of the Data Source dialog box takes you to Advanced Settings:

Advanced settings presently consist of the following:

Log System Data WattPlot can capture raw system data and write it to text files.  This 
capability is applicable to all connection types (except Data File), and is 
turned on or off with the Log System Data box.  There are two supported 
formats:
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Raw data There is one file per MATE per day, found in the WattPlot Data folder and
capture (OBM) named yyyy-mm-dd_n.obm, where yyyy-mm-dd is the date and n is the

number of the MATE (typically “1”).  Files of this format can be used for 
simulations, using a Data Source of Data File.
NOTE:  The MATE transmits approximately 3 KB per minute for each 
device, so the captured data file will grow by over 175 KB per device every 
hour.

Spreadsheet Creates the equivalent of the MATE3 SD Card data files (compressed 
format).

logs (.CSV) There is one file per hour, found in the WattPlot Data folder and named 
yymmddhh.csv, where yymmddhh is the date and hour.  (This option is 
not available to systems defined with more than one MATE.)
NOTE:  Each hourly data file will be about 185 KB per device every hour.

Device Time Zone Certain events and tally resets take place at midnight.  If the system you are 
monitoring is in a different time zone, you can select it here in order to keep 
your data and automatic actions synchronized with the actual system events.  
Otherwise, we recommend that you just leave it as “Same”.

Packet Frequency Some communication protocols (AXS Port and Data File) support variable 
data frequency.  This allows less frequent polling of an AXS Port, or faster 
simulations from data files.  Most OutBack devices are fixed at status data 
being sent every second.

NOTE:  The TCP/IP Server function is not available when using the Fast 
setting for Data File simulations, since clients will not be expecting data 
packets at twice the frequency.

Hide Advanced Settings Hides the Advanced Settings panel and returns you to the full Data Source 
dialog box.

The bottom of line of the Advanced Settings panel tells you where WattPlot is logging system data.  This 
can be altered from the Options menu.

NOTE:  WattPlot only allows you to click the OK button when the communication settings have been 
confirmed.  In this case, you will typically see OutBack system data in the results window and a Status of 
Active in the bottom left of the dialog box.  Even if you have not changed you communication 
parameters, you may in some cases have to click the Test Communication button in order to enable the 
OK button so that you can save other settings.
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Using the WattPlot™ NetMATE Program

Program Display

Once the WattPlot NetMATE program is configured, there is very little user interaction required.  There 
are six main display components.  The two main Status boxes on the left are colour-coded:

GREEN – everything is running normally
YELLOW – something is not (yet) running
RED – there is a problem that requires user intervention.

System Status

The system name and some basic
system information (such as 
battery voltage, state-of-charge, 
main device operational mode – 
specifics depend on what devices
are being monitored) will be 
shown in the blue title bar.

TCP Server Status

This shows the current status of 
NetMATE’s TCP Server.  It will tell 
you what IP Address and port TCP 
clients should use to piggy-back on 
to the data stream.  It also gives an 
indication of whether or a password 
is required to connect in.

TCP Client List

WattPlot NetMATE will 
attempt to show as much 
identifying information as 
possible about the TCP clients
currently receiving copies of 
the MATE data stream.

Data Stream Status

This shows the current status of 
the communication link to the 
MATE.  If you minimize the 
program down to your Windows 
Task Bar, the program caption 
will reflect the current Data 
Stream Status.

Alert Detected

If the program encounters an alert that 
triggers an email notification, a red box 
will appear below the Data Stream 
Status, informing you that a notification 
has been sent.  This box will disappear 
when the alert condition that triggered 
the notification is cleared.

TCP Client 
Summary

The text in the bottom 
right corner is a summary 
of the present TCP client 
connections.
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Program Menus

All of WattPlot NetMATE’s functional configuration is accessible by menu entries, as described below.

File – License Activation

When you first download and install WattPlot NetMATE, you will be issued with a trial activation, good 
for about two weeks.  If you decide to order a permanent activation, WattPlot will issue you with a 
permanent activation key, which must be entered from this menu option.  Selecting Licence Activation 
will present you with the Activation dialog box, where you may enter the activation key.

File – Move License to New PC

(Please see the section on Moving Your WattPlot NetMATE License.)

File – Check for New Release

If NetMATE is running on a computer with internet access, you can ask it to check for new releases of the
program itself.  This is similar to what it already does automatically when you first run the program.  All 
notifications will include a few notes about the program changes, and a link to read more details and to 
download the latest version.

The frequency with which you will be informed of a new release is configurable using the drop-down 
menu at the bottom of the Special Notifications screen:

Selected Option Effect

List new releases, checking every 10 days

Whenever a new version of WattPlot NetMATE is 
released into production, the program will notify 
you no more often than every 10 days.

List new releases, checking every 24 days

Whenever a new version of WattPlot NetMATE is 
released into production, the program will notify 
you no more often than every 24 days.  (Default)

List new releases, checking every 90 days

Whenever a new version of WattPlot NetMATE is 
released into production, the program will notify 
you no more often than every 90 days.

Disable all release and special notifications

You will not be automatically notified of any new 
releases or special notifications.  If you select this 
option, it is recommended that you do a manual 
check from the Options menu every 6 months.

Note that normally special notifications are one-time messages that only appear once (at program start up)
and will not be repeated.  However, if you use this menu option to check for new releases and special 
notifications, all current special notifications will be shown.

File – View Current Log

Opens the current log of program and system events, including warnings, errors and notifications.
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See the NetMATE Log Window section for more
information

File – Open Archived Log

Prompts you to select an archived NetMATE log
and opens it in the standard WattPlot Log window,
as shown at right.  See the NetMATE Log
Window section for more information.

File – Exit

Shuts down WattPlot NetMATE and exits the application.

System – System Name

WattPlot NetMATE can be used to monitor several different MATEs.  Each is defined by a separate 
System Name.  The program can only monitor and pass on the data stream from one MATE at a time – 
the current one being indicated by a check mark.  However, you can have more than one running instance 
of NetMATE in order to connect to multiple MATEs simultaneously, each with a different system 
selected.  Note that if you are using the TCP Server functionality, you would need to select a different IP 
Port for each system.

If you have multiple systems defined, WattPlot NetMATE
will prompt you for which system to connect to when it is
first run.  You can create shortcuts specific to a pre-selected
system which will bypass this prompt.  To do so, create a new
Windows shortcut for NetMATE, then go to the Properties
window of the shortcut, and append a space and the System
Name (in quotes) to the Target, as shown in the screen
fragment at right.  (Note that the full target is not shown –
"C:\Program Files\WattPlot\NetMATE.exe".)

You may also wish to rename the shortcut so that you know which system it refers to.

System – Add/Edit/Remove System

When WattPlot NetMATE is first installed and run, it will prompt you for the first System Name.  For 
most installations, this is the only System Name that will ever be needed.  If you have multiple MATEs to
connect to, you may wish to define more systems.  Selecting this menu option will present you with a list 
of defined systems:
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Choose the Add button to add a new system definition, or the Edit button to edit the selected system.  The
Add and Edit functions use the following screen:

System Name This is a brief descriptive name which identifies a particular MATE 
connection and the OutBack system that it monitors.  It will be included 
in any emails that WattPlot NetMATE sends out.  Note that System 
Names are set in the Add screen and are not editable in the Edit screen.  
To change the name, add a new system under the new name and remove 
the old one.

Data Folder This specifies where WattPlot will store configuration and performance 
data.  It is recommended that you accept the default, unless you already 
have WattPlot data elsewhere, or you have a particular need to store data 
in a separate location.  The folder will be created when you click the 
Save button, if it is not already present.

Description Use this free text field to give a more detailed description of the system.

Once a new system is added, it will be appended to the list under the WattPlot System menu.

Options – MATE Data Source

This menu selection takes you to the MATE Data Source dialog box.  This dialog box allows you to 
adjust the communication type and parameters for the MATE connection.  It also gives access to the 
TCP/IP Server Setup dialog box.  See the MATE Data Source Dialog Box section for details.

NOTE:  WattPlot NetMATE tracks the ‘device signature’ of every system that it is connected to.  If you 
alter the MATE Data Source and the program detects a change in the ‘device signature’, you will be 
prompted to either add a new system definition or confirm that the device signature has changed.  This 
can happen when you are switching to a different MATE3 or when you change the devices connected to 
your OutBack HUB.

Options – Email Settings

WattPlot NetMATE can use its built-in email functionality to activate your software, notify you of critical
OutBack system events, and send error messages to WattPlot’s technical support for fast resolution.  For 
details on configuring this functionality, see Email Settings.
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Options – Data Log Folder

NetMATE can log all incoming system data in a daily raw data file (with a .OBM extension) or hourly 
MATE3 SD card format files (with a .CSV extension).  See Advanced Settings of the MATE Data 
Source dialog box for more information on turning this option on or off, or for changing the file format.  
Use this menu entry to change the default folder that the program will use to store these daily files.

Options – Notification Options

WattPlot NetMATE can notify you of various important OutBack system events.  This menu entry allows
you to turn various categories of notification on or off, depending on your specific preferences:

Send Notifications by Email The top check box turns all notifications on or off.  If this box is blank, 
no email notifications will be sent and the settings below have no effect.

Device Error You’re notified if an OutBack device logs an error condition.  The email 
will identify the system, the device, and the error.

Device Warning You’re notified if an OutBack device logs an warning condition.  The 
email will identify the system, the device, and the warning.

Communication Failure You’re notified if NetMATE detects a communication error condition.

MATE Command Rcvd/Sent You’re notified if NetMATE receives a MATE command from a TCP 
client and passes it on to the MATE.

Battery Warning You’re notified if NetMATE itself detects an abnormal battery voltage 
condition.

NetMATE Autostarted You’re notified if the NetMATE program is started from the Windows 
Startup menu.  This may indicate a system reboot.

TCP Server Start Failure You’re notified if the NetMATE TCP Server fails to start.

TCP Server Stopped You’re notified if the NetMATE TCP Server stops unexpectedly.
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TCP Client Accepted You’re notified if the NetMATE TCP Server accepts a connection from a
TCP client.

Options – Windows AutoStart

Many WattPlot NetMATE installations run unattended or have NetMATE running full-time.  In such 
cases, you may want NetMATE to be started automatically when Windows starts.  To do this, simply 
click on the Windows Autostart entry of the Options menu to click it ON (indicated by a check mark).  
NetMATE will create a shortcut in your Windows Startup menu called “WPNetMateAutoStart 
systemname.lnk”, where systemname is the name of the currently selected system.

You use the same menu entry to turn AutoStart OFF and remove the shortcut.  Note that there is a 
separate entry in the Notification Options dialog box for NetMATE to notify you whenever the program 
is auto-started from this shortcut (which may indicate a Windows reboot).

Help – NetMATE User’s Guide

This menu entry will call up this User’s Guide as a hyperlinked and searchable PDF file.

Help – About

WattPlot NetMATE’s About screen provides
useful information such as the current
program version number, the unique PC ID,
etc., as shown at right.  The two paths in red
indicate where the program EXE file is
running from and what the default data folder
is for this system.

Help – WattPlot.com

This menu entry has a sub-menu with three options.  Each one will take you directly to a different page of
the WattPlot website:  Frequently Asked Questions, Home Page, and Order Page (for purchasing 
licenses).
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NetMATE Log Window

WattPlot™ NetMATE keeps its
own log of significant events,
notifications, communication
errors, etc.  These can be viewed
by selecting View Log from the 
File menu, which presents the
NetMATE Log Window, as
shown at right:

Searching and Sorting Logs

The log window has a built-in search capability to find entries with specific text, accessible from the 
Show Search button.  Also, the log may be viewed sorted by date, device, or entry type.  In each case, it 
may also be viewed with the most recent entries first or last.

Archived Logs

To view archived logs, use the File…Open menu entry and select the log that you wish to view.  
Archived logs are stored in a NetMATE sub-folder of the Logs folder, using a dated file name.  For 
example:

C:\ProgramData\WattPlot\Anderson Home\NetMATE\2006-03-07_NetMATE.log

Exporting Log Contents to a Text File

The contents of any text log may be exported to a text file by clicking the Export Text… button, and 
specifying a text file.  The text is exported with the same sorting as is shown in the current log display.

Archiving / Clearing Logs

To archive log entries into a separate log file, click the log’s Archive & Clear button.  The current file 
will be copied to an archive file, and then the currently file will be deleted and the displayed entries will 
be cleared.

Clicking the Delete Log Entries button will permanently delete the entries from the current log file and
clear the displayed entries.
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Getting Data from WattPlot™ NetMATE

One of the primary functions of WattPlot NetMATE is to supply a MATE or MATE3 data stream to other
WattPlot programs.  The following describes the steps required to set up WattPlot NetMATE’s TCP/IP 
Server.  The next section will cover the steps to perform on the TCP/IP Client computer that is to ‘piggy-
back’ on to the Server to receive the data.  Note that any number of computers can receive the same data 
stream concurrently.  Also the same computer may be used as both Server and Client, but this may 
require some extra set up, as described in Server and Client on Same Computer.

network or internet

may require routers, modems, etc.

Computer running Computer(s) running WattPlot program
WattPlot NetMATE such as Monitor, VisualMATE, etc.

TCP/IP Server Setup

STEP 1. From the Options menu, choose MATE Data Source to call up the MATE Data Source 
Dialog box.

STEP 2. Click on the Setup TCP Server button.  The WattPlot TCP/IP Server Dialog box will be 
displayed, as described in the next section.

STEP 3. Select the level of security that you desire for access and MATE Command transmission.  
Specify an IP Port of your choosing, and set a Password if required by your selected security 
level.  If you are connecting to a MATE3 in order to feed data to the older WattPlot 4 
Monitor program (version between 4.7.1 and 5.0.0), then check the Original MATE data 
format box to convert the MATE3 data stream to a compatible format.  Save your settings.  
You can just Cancel from the MATE Data Source dialog box.

STEP 4. That’s it!  WattPlot NetMATE’s main screen should now reflect the fact that the TCP Server 
is running and waiting for connection requests.

NOTE: You may get a warning message from your resident protection software, informing you that the 
WattPlot NetMATE program has opened a TCP port to the outside world.  For example:

built by intal act version 5.1.0 © Copyright 2016, Andrew Welch.  All rights reserved.



WattPlot™ NetMATE – User’s Guide 34

As this could be a security issue if the program were doing it without your knowledge, you are 
being asked to confirm permission for the WattPlot TCP Server to make data available to other 
programs.  In the example above, you will need to select Unblock for NetMATE’s TCP Server 
to be able to accept requests from other programs for data.  This warning will only be presented
once.

TCP/IP Client Setup

STEP 1. Start up the WattPlot program that is to receive the data.  Examples include the WattPlot 
Monitor program (version 4.7.1 and higher), WattPlot VisualMATE, WattPlot ShowMATE, 
etc.

STEP 2. If the receiving program has a System menu, you might want to add a new System definition
to correspond to WattPlot NetMATE as a MATE Data Source.  (See the System Add 
function.)  If the receiving program is on the same computer, this is not optional.  (See 
Server and Client on Same Computer).

STEP 3. From the Options menu of the receiving program, choose MATE Data Source to call up the
MATE Data Source Dialog box.

STEP 4. Select the TCP/IP connection method, and enter the IP name or address of the computer 
running WattPlot NetMATE with the TCP Server enabled.  (This may be the same computer  
- see Server and Client on Same Computer.)  You will also need to enter the IP port that 
you defined on the TCP Server as the Listening port, and the password if you defined one.  
See the MATE Data Source dialog box section for details.

STEP 5. If WattPlot NetMATE is already Active, you can click the Test button in the MATE Data 
Source dialog box on the receiving computer to confirm that you are receiving the data 
stream correctly.  Click OK to save the new MATE Data Source settings.

STEP 6. That’s it!  Your receiving WattPlot program will now operate as a TCP Client, just as if it 
were connected directly to the MATE.  Note that you can connect as many TCP Clients as you
like to the main WattPlot NetMATE TCP Server.
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WattPlot TCP/IP Server Dialog Box

The first step in sharing WattPlot data between computers is to setup the built-in WattPlot TCP/IP Server.
This is done from the MATE Data Source dialog box (of the WattPlot already connected to the MATE) 
by clicking the WattPlot as TCP Server button, which will present the following window:

OK Click this button to save your settings and to immediately apply them, 
including restarting the TCP server.  For example, if you change the 
password or restrict access, then all current TCP clients will be 
disconnected and they will have to reconnect using the new password.

Allow Connection? There are three levels of Server access, which determine which TCP/IP 
clients will be able to connect in to this program’s data stream:

DISABLED.........No connections will be accepted.
RESTRICTED. . .Only WattPlot connections using the Password 

defined on this screen will be accepted.
OPEN.................All connections will be accepted.

Allow MATE Commands? There are three levels of MATE command access, which determine 
which TCP/IP clients will be able to send commands to the MATE being
monitored by this program:

DISABLED.........No MATE commands will be accepted.
RESTRICTED. . .Only WattPlot connections using the Password 

defined on this screen can send commands.
OPEN.................Any connections can send a MATE command (NOT 

RECOMMENDED).
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Edit IP A potential TCP Client needs a Server IP – that being the local IP 
address of this computer – in this format: ###.###.###.###.  
Normally WattPlot can easily determine the IP address of the computer 
that it’s running on, and it will display it in the instructions, as shown 
above.  However, in rare circumstances (such as when WattPlot is being 
run under Windows emulation software), you will have to determine the 
IP address yourself.  (The IP address can usually be determined by going 
to the Windows Command Prompt and running “ipconfig”.)  You can
then supply it here by clicking the Edit IP button so WattPlot has a 
record of it, but remember – it is the TCP Client that needs this setting, 
not the Server!

This computer is The IP name and address of this computer will be shown.  If the IP 
address begins with “192.168…”, then this is likely a local network 
address that is not accessible outside the network (i.e. over the internet).  
Contact your network administrator and/or internet service provider to 
inquire about Static internet-accessible IP addresses.

When you are configuring another WattPlot to connect in to this TCP 
Server, this is the IP address that you will specify to use for that 
connection.

Listening Port This is the IP port where this TCP server will be listening for connection 
requests from outside TCP clients.  Your computer may be using various 
IP ports for a variety of tasks.  We recommend using the default (9091) 
unless you are familiar with IP networking.

When you are configuring another WattPlot to connect in to this TCP 
Server, this is the IP port that you will specify to use for that connection.

Password If you have specified RESTRICTED access for either the data or MATE
commands, you will need to specify the password required.

When you are configuring another WattPlot to connect in to this TCP 
Server, this is the password that you will specify to use for that 
connection.

Show/Hide Click this button to temporarily unmask this password display.

Original MATE Data Format If the Server is monitoring a MATE3 data stream, it is possible by 
checking this option to have it send the same data out to all TCP Clients 
in the original MATE data format (which is slightly different.  Now that 
all WattPlot tools can recognize both formats, this legacy feature should 
no longer be required.

The WattPlot TCP Server will automatically start every time the program is run, so long as Allow 
Connection? is set to Restricted or Open.  Exiting the program will close the TCP server.
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Server and Client on Same Computer

WattPlot NetMATE can run as a TCP Server, sending data to other WattPlot applications on the same 
computer, however you will have to define multiple systems in order to keep all of the communication 
parameters separate.

If you are adding NetMATE to an existing WattPlot set up (e.g. system already defined as “Anderson 
Home”), then you should define a separate system for NetMATE (e.g. new system of “Anderson Home 
MATE3”).

If you are adding an different WattPlot application to an existing NetMATE installation (e.g. system 
already defined as “Anderson Home”), then you should define a separate system for the new application 
(e.g. new system of “Anderson Home NetMATE”).

The MATE Data Source for your NetMATE TCP Server will be the MATE/MATE3 itself, so the 
NetMATE system will be configured for whatever communication protocol is being used.

The MATE Data Source for your Client program’s system will be a TCP/IP connection into the 
NetMATE application.  This is why two system definitions are needed if both applications are running on
the same computer.

When multiple systems are defined, you will be prompted to specify which system to open with for each 
WattPlot application.  You can avoid this step by specifying the system name in the shortcut to each 
application.  (See how to do this in the System Name section.)

Here is the optimum sequence of installation steps for a new installation:

PART 1

1. Download and run the installation program for WattPlot NetMATE.

2. When you are prompted to enter a system name, put in a descriptive name for your OutBack 
system, such as "Anderson Home".  (See NetMATE Program Installation, STEP 10.)

3. Once your NetMATE trial is activated, define the MATE Data Source for your MATE3, using 
either the UDP/IP or serial/USB connection types, depending on the hardware installed in your 
MATE3.  (See MATE Data Source Definition.)

4. Setup your MATE3 for data transmission.  (See MATE3 Setup.)

5. When you have confirmed that NetMATE is Active and monitoring your MATE3 data stream, go
back to the MATE Data Source Dialog Box and set up the TCP Server function.  Remember to 
check the "Original MATE Data Format" box!  (See WattPlot TCP/IP Server Dialog Box.)

6. Now go to the NetMATE Systems menu, and Add a new system definition.  We suggest naming 
it something like "Anderson Home MATE3", but changing its Data Folder to be the same as for 
the original system that you defined (e.g. "c:\ProgramData\WattPlot\Anderson Home").  (See 
System - Add/Edit.)
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7. Do not define a MATE Data Source for the new system definition – the new system will be 
defined and used by the other WattPlot application. Instead, switch NetMATE back to the 
original system (e.g. "Anderson Home") by selecting it from the Systems menu.

8. Exit WattPlot NetMATE.

PART 2

9. Download and run the installation program for the other WattPlot application.

10. When you run it, the program should present you with a selection of the two systems defined in 
NetMATE.  Select the second system that you defined (e.g. "Anderson Home MATE3").

11. Start WattPlot NetMATE to start the TCP/IP Server, then leave it running and come back to the 
other WattPlot program.

12. From the Options menu of the other WattPlot program, define the MATE Data Source as being a 
TCP/IP Server connection, and point it to the TCP/IP Server of NetMATE.  (See TCP/IP 
Connection.)

13. If all has been setup properly, you should be seeing your MATE3 data coming into the WattPlot 
Monitor program.

built by intal act version 5.1.0 © Copyright 2016, Andrew Welch.  All rights reserved.



WattPlot™ NetMATE – User’s Guide 39

Licensing, Updates, and Upgrades

Once your one-time license fee payment is received and processed, you will be sent a permanent 
activation code by email.  The WattPlot NetMATE software will be licensed to run for a specific 
combination of PC and OutBack MATE/MATE3.

At this time, updates to any of the application programs may be downloaded free of charge, from 
http://WattPlot.com/update.htm , and do not require repeat licensing.  If the program is 
running on a computer that has internet access, you will be informed of significant updates automatically, 
or you can have the program check on request using the Manual Release Check function.

Moving your WattPlot™ NetMATE License

Your WattPlot NetMATE program license is unique to the PC and hard drive that you installed it on.  If 
you wish to move WattPlot to another computer or hard drive, you will need to remove the current license
and get a new activation.  In some situations, you can do this yourself, so long as you have configured 
WattPlot’s Email Settings and your computer can access the internet.  Otherwise, when you remove the 
license, WattPlot will issue you with a temporary license so that you may continue to use the product 
while waiting for the new activation from intallact.

Note that certain hardware changes to a computer can render a WattPlot license invalid.  If 
WattPlot detects this condition, it will revert to a temporary license so that you may continue to use the 
product while waiting for a license update from intallact.  If you know that you will be changing the hard 
drive where WattPlot is installed, we recommend doing a license move first, if possible, even if you have 
not yet installed WattPlot NetMATE in the new location.

If you have to move your license back to the original location, this can also be done, but it typically 
requires us to process the new Activation Code and send it to you.  Or you can simply order a new license
if you will require more than one.

The WattPlot Licence Move function is initiated by selecting the Move License to New PC option, 
under the File menu.  Note that this is a license move, not copy.  WattPlot will no longer be licensed at the
old location after the move.  The following steps outline the recommended procedure for removing your 
current license and moving it to a new location.  Please follow whichever steps are possible in your 
situation.

1. If applicable, fully install the WattPlot NetMATE program on the new computer or hard drive, as 
described in the NetMATE Program Installation section at the start of this manual.  [Note that the 
version of program running in the new location must be at least equal to or more recent than the 
version of the currently licensed copy.]

2. Run WattPlot NetMATE in the new location in order to get the Unique PC ID.  Write this down 
carefully.

3. Run WattPlot NetMATE at the old location, where it is already licensed, and select the Move 
License to New PC option, under the File menu.  A confirmation message will be displayed.  Click 
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the Yes if you have the new Unique PC ID.  Otherwise, click No to complete the first step of 
removing the current license.

4. The Activation Dialog Box will be displayed.  If you have the new PC ID, enter it now (including 
hyphens) in the yellow PC ID field, and then press the Enter key.

5. The main action button of the Activation Dialog Box will show the next possible step, based on your 
current situation.  The button will have one of the following labels:

Receive New Activation Code by Email
You can move this license yourself.  Your new activation code will be emailed to you automatically 
within minutes.

Request New Activation Code by Email
You can remove your current license and receive an immediate interim activation.  Intallact will be 
given your new PC ID and will send a you new Activation Code (usually within 24-48 hours).

Proceed With License Move    or    Remove This Activation License
You can remove your current license and receive an immediate interim activation.  When you have 
your new PC ID, You will have to email us at  activation @ WattPlot .com  so that we can 
get a valid Activation Code to you.  Note that we will also need to know your old PC ID and the 
License Removal Confirmation Code, as issued by this process.

6. You will probably want to copy the full contents of the WattPlot folder and any sub-folders to your 
new computer or hard drive, in order to retain all of your logged data and current system settings 
(most of which can be found in your WPConfig.ini and SystemName config.ini files).

7. When you receive your new Activation Code, go to the new installation of WattPlot NetMATE and 
use the new Activation Code to activate your license, as described in the Activation section.
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Problems, Feedback, & Suggestions

You will quickly learn that intallact is one of the most responsive developers around.  We are driven by 
the comments and ideas from our users, and rapidly address problems or implement enhancements.

Questions

If you have questions about how to use any of the WattPlot suite of programs, or what they can do, your 
best resource is to start with the Frequently Asked Questions section of our web site.  Go to:

http://WattPlot.com/faq.htm

If the question or answer you seek is not there, please refer to one of the other resources described below.

Solving or reporting problems

If you have a question or you encounter some other difficulty, you are encouraged to contact us by email. 
A screen shot is often useful, acquired by holding down the Ctrl and Alt keys and pressing the Print Scrn 
key.  (You can then Paste the screen shot into an email or Word document, sent as an attachment.)  We 
will work hard to get your issue resolved as soon as possible.

WARNING: Do NOT try to uninstall and reinstall the software.  It won’t help and 
you will likely corrupt your system and data files.  Contact WattPlot support first.

Making suggestions

If there is anything in this User’s Guide that you find unclear, missing, or incorrect, please let us know so 
that we can set the matter straight for you and future users.

If you have an idea about how we can improve our applications or you have a specific need, we would 
love to try and implement your idea.  Send us an email!

techsupport @ WattPlot .com
http://WattPlot.com
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Appendix A -  Serial Cable Specifications

Your OutBack MATE must be connected to your computer in order for the monitor program to receive 
data from your MATE.  This connection is via a serial cable.  The serial port on the MATE is a female 9-
pin (DB09) connector underneath the menu buttons and next to the network cable port.  You will 
therefore need a serial cable with a male DB09 end at the MATE end.  The other end of the cable plugs 
into an RS-232 serial communications port on your computer.  Serial ports on computers come in three 
types:

USB Port 9-pin (DB09) 25-pin (DB25)

USB port

The latest standard found on computers are USB ports.  Adaptors can be purchased at computer 
accessories suppliers to convert USB ports to conventional serial ports.  The adaptor will convert it to 
either a 9-pin or a 25-pin serial port (see below).  NOTE: Not every serial/USB conversion kit on the 
market seems to work with the opto-isolated serial port of the OutBack MATE!

9-pin (DB09) port

Until recently, many computers came with a male 9-
pin serial port on the back.  If your computer has one
of these, then the computer end of your serial cable
should be a female 9-pin.  Note that the serial cable
uses pins 2, 3, 4, 5, and 7 (as shown at right).

All pins are straight through with no jumpering.

25-pin (DB25) port

Older computers came with a (typically) male 25-
pin serial port on the back.  This should not be
confused with the typically female 25-pin parallel
(printer) ports.  If you have one of these 25-pin
male serial ports, you will need an adapter to
convert from 9-pin to 25-pin.  This adapter must
produce the result shown, where the pin numbers
on the left are for the 9-pin and those on the right
are for the 25-pin:

All pins are straight through with no jumpering.

Note that computer accessories suppliers also sell male-to-female and female-to-male converters (for both
9-pin and 25-pin types) if you need to change the kind of end found on your cable.

Serial cable lengths in excess of 25 feet are not usually recommended, as they can lead to increased 
communication errors.
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Appendix B -  OutBack Warnings and Errors

The Outback MATE can detect a number of different warning and error conditions coming from inverters
and charge controllers, which are passed on in the data stream.  WattPlot NetMATE can notify you of 
these device errors or warnings by email, if you turn on that functionality.  See Notification Options.

FX warnings will not shutdown the inverter affected, but errors will.  An error on the Master inverter will 
shut the OutBack system down.

This appendix describes some of the errors and warnings detected (sorted alphabetically by message), 
how they are noted, and what they mean.

Inverter Warnings

Warning Trigger Meaning/Response
AC Input 
Frequency High

AC Input frequency is above 
66 Hz (55 Hz on export 
models)

The FX is approaching the upper limit of its frequency window 
and will drop the AC source if the frequency gets much higher.

AC Input 
Frequency Low

AC Input frequency is below 
54 Hz (45 Hz on export 
models)

The FX is approaching the lower limit of its frequency window 
and will drop the AC source if the frequency gets much lower.

Buy Amps 
Exceeds Input 
Size

The AC Input current exceeds 
the rating allowed for that 
model of inverter.

The AC loads are drawing more current than the rating of the FX 
allows.  Exceeding this current limit for an extended period of 
time could cause
the FX to fail.  Reduce the loads on the FX’s AC output to 
prevent damage.

Communication 
Error

An internal communication 
error has been detected 
between the Mate and the FX.

This warning may occur if the communication lines between the 
FX and the MATE have been severed.  If this is the case, turn 
the FX “off” and then “on” through the DC disconnect.  If this 
does not solve the problem, call OutBack for assistance.

Fan Failure The fan mounted above the 
transformer inside the FX has 
stopped working or is not 
functioning properly.

This will eventually cause an Over Temperature inverter error if 
the cause of the fan failure is not fixed.  Restart the FX and listen
for the fan to verify a fan failure.  The fan should run for about 15
seconds on start-up.

Input VAC High AC source voltage exceeds 
the upper limit defined in the 
Mate’s ADV/FX/GRID menu.  
Default is 140 VAC (270 VAC 
on export models).

The AC source (grid or generator) input voltage is too high.  If an
AC source was just applied to the FX, the FX will not connect to 
that source until the voltage drops below the upper limit.

Input VAC Low AC source voltage exceeds 
the lower limit defined in the 
Mate’s ADV/FX/GRID menu.  
Default is 108 VAC (208 VAC 
on export models).

The AC source (grid or generator) input voltage is too low.  If an 
AC source was just applied to the FX, the FX will not connect to 
that source until the voltage rises above the lower limit.  A power 
outage will often trigger this warning.

NOTE:  FX inverters occasionally detect an induced voltage on 
the AC Input terminals of up to 10 VAC, even if they are not 
connected to an AC source or the grid is down.  WattPlot 
suppresses this warning at such voltage levels.

Temperature 
Sensor Failed

One of the temperature 
sensors internally located in 
the FX is not working correctly.

The FX needs to be checked by a qualified repair technician.  
Note that the AirTemp, FETtemp and CapTemp warnings listed 
in the Mate’s STATUS/FX/WARN menu can help with 
troubleshooting.
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Inverter Errors

Error Trigger Meaning/Response
Backfeed Another AC source of power 

was connected to the AC 
output of the FX.

Usually this is an installation issue. It often occurs when there is 
an X-240 transformer in the system that hasn’t been installed 
properly.  Also, check that there are no connections between the 
AC input and AC output circuitry.

High Battery The battery voltage rose above
the high battery voltage level 
(40.0 volts for a 24V FX) for 10
seconds.

The inverter will restart once the battery voltage drops below the 
high battery voltage level (40.0 volts for a 24V FX) for at least 1 
second.

Low Battery The battery voltage dropped 
below the Low Battery Cut-Out
(LBCO) voltage set point for 5 
minutes.  (Default LBCO is 
21.0 volts for a 24V FX.)

The inverter will restart once the battery voltage exceeds the 
Low Battery Cut-In (LBCI) voltage set point for 10 minutes. 
(Default LBCI is 25.0 volts for a 24V FX.)

Low VAC 
Output

The inverter was not able to 
maintain adequate AC output 
voltage to power the loads 
connected.  AC output 
dropped below 105 VAC (200 
VAC for export models).

This is typically caused by the AC loads demanding more power 
than the inverter is able to deliver.

Over 
Temperature

The FX reached its maximum 
allowed internal operating 
temperature.

This can be caused by powering large AC loads or charging for 
too long.  It can also be caused by restricting the amount of air 
which is able to flow around the casting, or by operation in high 
temperature environments.  The inverter will automatically reset 
and resume operation once it cools down.

Phase Loss n/a Phase Loss error detection has not yet been implemented by 
Outback, and is not operational at this time.  Please inform 
intallact if this error is triggered on your system.

Shorted Output The inverter immediately 
reached its maximum current 
and shut down.

This is usually caused by a short circuit condition on the AC 
output, but can also be caused by attempting to operate a load 
which far exceeded the inverter output capability.

Stacking Error A problem has occurred with 
the communication cabling 
between stacked inverters, or 
the inverters are stacked 
incorrectly.

Check the stacking programming on the Mate.  If this condition 
persists contact your dealer for servicing instructions.
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WattPlot Data Communication Errors

Error Trigger Meaning/Response
Communication 
Check Sum 
Failed

MATE status line check-sum 
was incorrect.

Data integrity error.*

Every status line sent by the MATE has a check-sum to ensure 
data integrity.  If the check-sum test does not pass, it suggests 
that some data corruption happened with that packet and the 
check-sum error is logged.

Communication 
Delimiter Check 
Failed

Missing or extra delimiters, or 
unexpected characters in 
MATE status line.

Data integrity error.

MATE status lines begin with a linefeed character (ASCII 010), 
end with a carriage-return character (ASCII 013), and are divided
into separate fields by delimiters (commas).  Everything else is a 
numeric character.  Taking away all of the numeric characters 
should leave the same delimiters every time.  If it doesn't, then 
the status line is invalid and this error is logged.

Communication 
Delimiter 
Positions Check 
Failed

Unexpected characters in 
delimiter positions in MATE 
status line.

Data integrity error.

MATE status lines are divided into separate fields by delimiters 
(commas) in fixed positions.  If all of the commas are not in the 
expected positions, then the status line is invalid and this error is 
logged.

Communication 
Packet Too 
Short

MATE status line had fewer 
than 49 characters.

Data integrity error.

All status lines sent by the MATE should be at least 49 
characters (bytes) long.  WattPlot detected a status line that 
appeared to be missing characters.

Communication
s Timed Out

WattPlot did not detect any 
data coming from the MATE 
for about 9 seconds.

Status lines should be sent by the MATE every second.  No data
for about 9 seconds, triggers this error.  If nothing is received for 
about a minute, then the program will give-up and close the data 
receiving session, unless the Auto-Start option is turned on.

Component 
Address 
Undefined

Port address in Mate status 
line is for a component that 
was not defined in the 
WattPlot System Components 
window.

The MATE can send data for a number of components.  Each 
status line corresponds to a single component, identified by a 
port address.  WattPlot received a status line for a component 
that was not defined in the WattPlot System Components screen.

All components attached to the MATE or OutBack Hub should be
defined so that WattPlot can expect the data and handle it 
correctly.  The System Components window is accessible from 
the WattPlot Options menu.

Component 
Address Invalid

Invalid port address character 
in Mate status line.

Data integrity error.

The MATE can send data for a number of components.  Each 
status line corresponds to a single component, identified by a 
port address.  WattPlot detected a status line with an invalid 
component port address, suggesting data corruption or a MATE 
problem.

Invalid Status 
Line From Mate

Invalid leading character for 
Mate status line.

Data integrity error.*

All valid status lines from the MATE begin with a LineFeed 
character (ASCII 010).  If a different character is detected as the 
leading character, it is noted and this error is logged.

* Certain errors are flagged as a “Data integrity error”.  One or two of these might be expected when a 
data receive session is first started (before WattPlot and the MATE are synchronised), or if buttons are 
being pressed on the MATE, and do not indicate a problem.  If they are more frequent, and occurring 
mid-session with no MATE buttons being pressed, it usually indicates a problem in the serial cable 
connection or length.  (See Appendix B – Troubleshooting Serial COM Port.)
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WattPlot Data Communication Errors - continued

Error Trigger Meaning/Response
Invalid Port 
Number

The serial COM port selected 
does not exist or is not 
accessible.

WattPlot typically does not include such ports in the dropdown 
list of your System Components screen, so this error is rare.  Go 
to the MATE Data Source screen (from the Options menu), and 
select the correct COM port that the Mate cable plugs into.

No Serial COM 
Ports Accessible
from Windows 
Environment

Either there are no serial ports 
on your computer, or Windows
did not detect them.

To check this outside WattPlot, (in most Windows environments) 
right-click on the “My Computer” icon and choose Properties.  
From the “Hardware” tab, click on “Device Manager”.  There 
should be an entry called “Ports (COM & LPT)”.  Expand the 
entry to see the list of ports detected and look for problems that 
Windows may have detected.  Right-clicking the port icon and 
choosing “Properties” will give you more information about a 
specific port.

Port Already in 
Use by Another 
Program

The serial COM port selected 
for WattPlot is already in use 
by another program.

If you have other MATE monitoring software, PDA 
synchronization software, or a serial mouse, any one of these 
may already be using the serial port selected.  You will have to 
select a different serial COM port and ensure that the cable from 
your MATE is plugged into the port selected.

TCP/IP 
connection 
closed by MATE
server

The remote WattPlot TCP 
server closed this connection.

The remote WattPlot program providing MATE data to this 
program has closed the connection.  Perhaps the remote 
WattPlot was closed down or the user there changed the TCP/IP
Server permissions.

Unable to open 
communication 
link to MATE

Any unrecoverable connection 
error preventing link from 
being opened.

The reasons for this error will vary, but are most commonly 
related to the settings chosen for the MATE Data Source.

WattPlot Program Errors

Error Trigger Meaning/Response
Activation Code 
Expired

User attempted to activate 
WattPlot with an expired 
activation code.

There are two kinds of activation codes from intallact: 
Evaluation and Permanent.  An evaluation activation code is 
typically valid for about 15 days from the date it is sent to you, 
not the date that you first use it.  If the code expired before you 
could use it, contact us at activation @ WattPlot .com.

Authorization 
Failed

Invalid activation code or other
licensing error.

There are a number of things that can trigger this error.  Please 
send the exact text of the error message to us at activation @
WattPlot .com.

Configuration 
Corrupted

An inconsistency in the 
WattPlot configuration file.

WattPlot keeps a lot of configuration information in a data file 
(systemname config.ini) in its application folder.  If 
WattPlot detects an inconsistency in this file, then this error will 
be generated.  If you get this error, attach the configuration file to
an email & send it to us at techsupport @ WattPlot .com.

Encountered 
invalid log data

Unexpected values in 
WattPlot’s own data files.

Data corruption error, indicating a data storage problem, 
inappropriate manual editing, or a program bug that we should 
know about.  Please send data file to us at techsupport @ 

WattPlot .com.

(continued on next page)
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WattPlot Program Errors - continued

Error Trigger Meaning/Response
Installation 
Aborted 
(Licensing Error 
Code)

Internal error from a Windows
function.

This is an internal licensing error related to Windows.  Please 
contact us at activation @ WattPlot .com if you get this 
error.

Installation 
Aborted 
(Unrecognized 
MATE Serial 
Number)

User entered an invalid 
MATE serial number.

For MATE/MATE2 devices:  Be sure to include the “MA” and all 
leading zeroes when entering your MATE serial number.

For MATE3 devices:  Be sure to include the “M” when entering 
your MATE serial number.

Invalid Serial 
COM Port

WattPlot cannot use specified
COM port to receive data.

(See the specific error in the preceding WattPlot Data 
Communication Errors section.)

Software Expired Expiry date of temporary 
evaluation license has 
passed.

An evaluation activation code is typically valid for about 15 days 
from the date it is sent to you, not the date that you first use it.  If 
you need an evaluation period extension, contact us at  
activation @ WattPlot .com.  You can get information about
ordering a permanent WattPlot license at our web site: 
WattPlot.com/order.htm

Unrecoverable 
Communications 
Error

Too much invalid data 
received

OR
Insufficient data to pass 
integrity checks

OR
No data detected on serial 
port

OR
Serial Port closed 
unexpectedly while still 
attempting to receive data 
from Mate.

This error has one of four causes as listed at left.  Most will log 
other errors and well, and all of them will result in WattPlot 
closing the link to MATE.

The first three typically suggest a serious serial cable, port, or 
MATE problem.  The fourth trigger is an unexpected Windows 
error.

Unrecoverable 
Error - Inform 
intallact

Internal programming error. While we have attempted to anticipate every possible error 
condition, it is always possible that the WattPlot software will 
encounter an internal programming error.  While these are more 
and more rare, they almost always indicate something that our 
developer must address immediately.

This error is usually accompanied by extra information which, if 
emailed to us, will allow our programmer to quickly track down 
the cause of this error.
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